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Overview
StatTrak for Hockey is a hockey statistics management system for league, 
tournament, and individual teams.    Great for high school or any level of 
hockey.    Keeps records for up to 100 teams per directory (99 players per 
team).    Tracks team and player statistics, team scoring, game results, 
won/lost record, and team standings.    All StatTrak reports can be computed 
for any combination of games.    You can design and save any number of    
player statistics report formats, name additional categories, and sort on any 
category.    Reports can be printed or saved to disk.    This program will be 
upgraded every year!

Unless this is a demo (shareware) version of StatTrak for Hockey, you must 
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you must immediately register with ALL-PRO 
Software or delete the program.    See the Registration Section for 
registration details and benefits.
Start the program and select one or more teams.    Select Update from the 
Main Menu to update game and player results.    Player results can be 
entered from a score book or you can increment totals as the game is being 
played.    Select Reports from the Main Menu to display player statistics, 
goalie statistics, team scoring, game results, won/lost record, and team 
standings reports.
Back up your data regularly to protect against loss due to power failure, disk 
damage, or other mishaps.    This is very important!



First Game
To add your first game, select "Team 1", or another team,    from the list of 
teams.    Then from the Update Menu, select Team Name and assign the team
name, select Roster and add players to the roster, and then select Games 
and add the game and player results for the first game.    When adding a 
game, all game and player results are optional and can be added, changed, 
or deleted at a later time.
You might want to set up your game types (league, conference, tournament, 
etc.), name additional categories you wish to track, and change your data 
directory before adding your first game.    Select Name Your Own from the 
Options Menu to set up your game types and categories.    Select Data 
Directory from the File Menu to select the directory you want to store your 
team and player files.



Select Teams
StatTrak lets you select one or more teams on the team list.    If you select 
more than one team, only the first team selected on the list can be updated.  
However, you can report on more than one team at a time.    If you select 
more than one team, the Team Scoring, Game Results, and Won/Lost Record 
options on the Reports Menu will be disabled.    If you select just one team, 
the Standings menu option will be disabled.    The Player Statistics and Goalie
Statistics menu options are available regardless of how many teams you 
select.
To select multiple teams, click and drag on the team list.    The Shift+click or 
Shift+arrow key extends the selection from the previously selected item to 
the current item.    Ctrl+click selects or deselects an item on the list.



File
Selecting File from the Main Menu provides the following menu options:

Data Directory - Select team and player file directory.
Back Up Files - Back up team and player files.
Restore Files - Restore team and player files.
Exit Program - Exit StatTrak for Hockey program.



Back Up Files
Select Back Up Files from the File Menu to make a copy of your team and 
player files for your current working directory.    You might want to make a 
backup copy to a floppy disk and to your hard drive.    This way you have a 
backup copy you can quickly restore from on your hard drive and a copy on a
floppy disk that you can use should you ever experience problems with your 
hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Restore Files
Select Restore Files from the File Menu to load a backup of your team and 
player files to the current working directory.    You can restore from a backup 
made to a floppy disk or another directory on your hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Help
Select Contents... from the Help Menu to run the StatTrak for Hockey Help 
Program.    Select About from the Help Menu to view the About Screen which 
shows the version number of StatTrak for Hockey and the All-Pro Software 
address.



Reports
To display reports, select one or more teams, select Reports from the Main 
Menu, and then select one of the following menu options:

Player Statistics
Goalie Statistics
Team Scoring
Game Results
Won/Lost Record
Standings

ALL StatTrak reports can be computed for any combination of games (all 
games, last 10 games, games 5 through 10, league games, etc.) and can be 
printed or saved to a disk file.



Player and Goalie Statistics Report
Select    Player Statistics or Goalie Statistics from the Reports Menu to display
team and player statistics.    Selecting Player Statistics will display statistics 
for players other than goalies.    The reports will show players from one or 
more teams depending on the number of teams selected.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.    Click Sort to sort the report on any 
category in ascending or descending order.    Click Format to select, add, 
change, or delete a report format. Format lets you select the categories you 
want on the report in the left to right order you want them.    You can create 
any number of report formats and save them to disk.    Click Player to display 
an individual's game by game statistics.    Click Minimum to divide the report 
into two groups based on a minimum number of games played or minutes 
played.
Use the vertical and horizontal scroll bars to scroll up/down and left/right on 
the report.    The scroll bars will only appear if scrolling is needed.    For 
example, if only three players appear on the report, the vertical scroll bar will
not be visible.
See Team and Player Statistics for a list of all categories that can appear on 
the reports and how they're calculated.
To view career statistics for a player, select two or more teams and then 
bring up either the Player Statistics Report or the Goalie Statistics Report.    
Then click Compute and enter a player's name or number and click OK. The 
report will display a statistics line for each team the player appeared in as 
well as a total line.    For example, if Jeff Elwood played on the 1996 Warriors 
and the 1997 Warriors, you would select both teams, bring up the Player 
Statistics Report, and then recompute the report for Jeff Elwood to see his 
1996, 1997, and career statistics.



Team Scoring Report
Select Team Scoring from the Reports Menu to display cumulative team 
scoring by periods, power-play attempts/goals/percent, and penalty-killing 
attempts/goals/percent for the selected team.    The report is only available if 
one team was selected.    The Team Scoring menu option will be disabled if 
two or more teams were selected.
Click Print to print the report or save it to a disk file .    Click Compute to 
compute the report for different games.



Game Results Report
Select Games Results from the Reports Menu to display game results for the 
selected team.    The report is only available if one team was selected.    The 
Game Results menu option will be disabled if two or more teams were 
selected.
Click Print to print the report or save it to a disk file .    Click Compute to 
compute the report for different games.      Click Short to display a one line 
game description which displays game number, game date, game type, 
opponents, and the score.    Click Long to display a more detailed game 
description which also shows the game location, game comment, and breaks
the scoring out by period.    Both reports can be printed.



Won/Lost Record Report
Select Won/Lost Record from the Reports Menu to display the won/lost record
for the selected team.    The report is only available if one team was selected.
The Won/Lost Record menu option will be disabled if two or more teams were
selected.
Games won, lost, tied, win percentage (Pct), goals for (GF), and goals against
(GA) are displayed for each game type that has recorded games and for total
games.    Goals for are the goals the selected team has scored and goals 
against are the goals allowed by the selected team.
Win percentage in computed as ((wins + ties) / total games) where wins are 
1 point, ties are 1/2 point, losses are 0 points, and total games are 1 point 
per game.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.



Team Standings Report
Select Standings from the Reports Menu to display team standings.    The 
report is only available if two or more teams were selected.    The Standings 
menu option will be disabled if less than two teams were selected.
Teams are listed in order of total points.    The report displays games won, 
lost, tied, win percentage (Pct), winning or losing streak (Streak), goals for 
(GF), goals against (GA), and total points (Pts).
Total points are computed as 2 points for every win and 1 point for every tie.
Goals for are the goals scored by a team and goals against are the goals 
allowed by a team.
Streak is the latest consecutive number of wins or losses by a team.    For 
example, if a team has lost its last 5 games then the Streak is "Lost 5".    If a 
team won its last game but lost the game before that, the Streak would be 
"Won 1".
Win Percentage is computed as ((wins + ties) / total games) where wins are 1
point, ties are 1/2 point, losses are 0 points, and total games are 1 point per 
game.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.
To create team standings, game scores must be recorded for all teams 
selected.    ONLY GAME SCORES are needed to create standings.    Game date,
location, etc., are not needed.    Player results are also not needed.    
However, each team must be added to StatTrak.    If team X plays team Y, 
you must add a game for team X and add a game for team Y.    Games for 
both teams can not be added at the same time.    They must be added 
separately.    However, you can add the game for Team X and then on the 
Game Screen for Team Y you can select Team X as the opponent and then 
click Import to copy the game screen information that was entered for Team 
X.    Scores and home team will be reversed when imported.



Compute Reports
From ALL StatTrak reports, you can click Compute to recompute the report 
using the following selection criteria on the Compute Screen:

*    Game Range - Any range of games from 1 to 999.
*    Game Types - Any combination of seven game types    (renamed from 

Name Your Own).
*    Special Select - Check box to use ONLY Special Selected games. Lets 

you compute for non-consecutive game numbers (i.e. 1,3,9).    You can 
Special Select games when updating a game on the Game Screen or by 
selecting games on the Compute Screen.    Selections are saved to disk.

*    Career Statistics - Enter player name or number to compute career 
statistics.    Only available from the Player and Goalie Statistics Reports 
when two or more teams are selected.

Click All from the Compute Screen to reset parameters for computing all 
games.    Click OK to compute report.



Print Reports
All StatTrak reports (Player Statistics, Goalie Statistics, Team Scoring, Game 
Results, Won/Lost Record, and Standings) can be printed or saved to a disk 
file.
When you print a report, you can either use the default report title or enter 
your own.    You can select from 1 to 50 copies and select the number of lines 
per page.    You can also select the font size for the report title and main body
of the report.    Some printers will not recognize font size but the report will 
still print.    Bold fonts can also be selected.    For the Player and Goalie 
Statistics Report you can choose to print just the top X number of players 
(i.e. League Leaders Report).
You can choose to create a report disk file instead of printing the report.    
Entering a file name will override printing.    You can specify a path with the 
file name and can either create a new report file, replace a report file, or 
append to an existing one.    Click Find... to search for a file.
Click Setup to bring up the Print Setup Screen to change print parameters 
such as Portrait or Landscape.



Update
To update team, player, and game information, select Update from the Main 
Menu and select one of the following menu options:

Games
Roster
Team Name
Change Player Number
Delete Files

A team must be selected before the menu options for Update are enabled.    
If more than one team is selected, only the first team selected on the team 
list can be updated.
* See also First Game.



Update Games
Select Games from the Update Menu to update game results.    The two 
components in updating a game are the Game Screen and the Player Screen.
General game information is (optionally) entered on the Game Screen and 
player results are (optionally) entered on the Player Screen.
After selecting Games from the Update Menu you will advance to the Game 
Menu.    Click Add Game to add a game.    Highlight a game on the Game List 
and click Change to change a game,    click Delete to delete a game, or click 
Insert to insert a game.    You can also double-click a game on the Game List 
to change it.    Clicking Add Game, Change, or Insert will take you to the 
Game Screen.      If you just want to update player results for a game already 
added, you can highlight the game on the Game List and then click Player 
Screen to go directly to the Player Screen.    When you delete a game, ALL 
player results recorded for that game will also be deleted (be careful)!
From the Game Screen, you can update game date, game location, 
opponent, goals scored by period, home team, Special Select, game type, 
game comment, power-play attempts/goals (PP/PPG), and penalty-killing 
attempts/kills (SH for short-handed/Kills) .    All entries on the Game Screen 
are optional, except game type.    Click OK to update game results.    When 
adding or inserting a game, clicking OK will automatically take you to the 
Player Screen.    However, when changing a game, clicking OK will take you 
back to the Game Menu.    Click Player Screen to advance to the Player 
Screen when changing a game when you also want to update player results.
One of seven game types is selected for every game updated (defaults to the
first game type when adding a game).    Game types can be renamed by 
selecting Name Your Own from the Options Menu.    All StatTrak reports can 
be computed by game type.    For example, you could name game type 1 
LEAGUE and game type 2 PRACTICE.    Then you would select the LEAGUE 
game type when updating league games and the PRACTICE game type when 
updating practice games.    Then you could compute any report for only 
league games, only practice games, or both league and practice games very 
easily.
If you are tracking statistics or standings for two teams that played each 
other, you don't need to enter the same Game Screen information for both 
teams.    Add the game for one team first.    Then on the Game Screen for the 
other team select the opponent from the Drop Down List Box and then click 
Import to initialize the game information (date, location, goals scored by 
period, game comment (optional), game type, PP/PPG, SH/Kills) from what 
was entered for the other team.
On the Game Screen you can check Special Select, which is used in 
computing reports.    For example, you could Special Select night games and 
then compute any report for night games.    You can also Special Select 



games from the Compute Screen.
The other component in updating a game is the Player Screen where 
individual player results are entered.    Entering player results is optional.    
You can always add results later.
Click on the Player Table to select a player to update.    The row clicked 
determines which player is selected and the column clicked determines if the
goalie or non-goalie input window is visible.    The Stats Area for the player 
selected will be highlighted and the player name will be displayed on the 
right.    You can either enter player results by keying them in or by clicking +1
or -1.    Using the +1 and -1 command buttons could be used to enter results 
as the game is being played.    A Hockey Stick/Puck Icon on the Player Table 
indicates player results have been entered.    Check Played in Game to mark 
appearance of player in game if no results need to be entered (you might 
want to give a player an appearance even though they didn't have any shots
on goal, saves, etc.).    Uncheck Played in Game to remove appearance of 
player (delete statistics) in game and to zero all entry fields.
If you plan to enter player results real-time (as the game is being played), 
you should periodically save the player results and then return to the Player 
Screen for that game.    Results are not saved until you click OK on the Player 
Screen.    It's a little more difficult to update player results for two teams real-
time because you can only work with one team at a time.    However, a future
version of StatTrak for Hockey will address the issue.
When entering player results you can record results for up to five Name Your 
Own categories.    These category names can be changed by selecting Name 
Your Own from the Options Menu.
Click Roster to add players to the roster.    The total number of players with 
results entered are displayed below the Player Table.
Click Team Totals to display the team totals.    This can be used as an auditing
tool.    Click Game Screen to go to the Game Screen.    Click OK to save all the
player results entered.    Click Cancel to cancel ALL the player results entered
(not the last player entered but ALL the players entered).    Clicking OK or 
Cancel will return you to the Game Menu.
See Team and Player Statistics for a list of all statistics that can be recorded 
and computed by StatTrak for Hockey.



Update Roster
Select Roster from the Update Menu to set up and maintain a team roster.    
Up to 99 players can be added for each team.    Select from the player list 
and enter or change the name, phone number, address, city, state, zip, and 
other player information.    Click Delete to delete a player name and related 
information from the roster.    Click Print to print the roster information.
Player names have an associated player number from 1 to 99.    One way to 
assign player numbers is to use the player's uniform number.    Currently, the 
only use of the player number is for computing career statistics.    However, 
career statistics can also be computed by player name.    The player number 
is used by StatTrak to identify players and does not appear on any reports.    
Deleting a player or changing a player name has NO effect on results 
recorded for that player number.    Player results relate to the player number, 
NOT the player name.
Don't get hung up on the player number.    It's a throw back from the DOS 
version of StatTrak for Baseball and will probably be eliminated in a future 
version of StatTrak for Hockey.



Update Team Name
Select Team Name from the Update Menu to assign or change a team name.  
You can assign a long team name and a short team name.    The short team 
name is only used on multiple team player statistics reports.    The long team 
name is used on all other reports and screens.    Click Default to assign the 
default team name based on the team number (i.e. Team 7).    You might 
want to include the year in the team name for documentation purposes (i.e. 
1997 Warriors).    This is especially helpful if you plan to record games for the 
same team in more than one year.
You might want to assign the team name before you set up the roster or add 
game results to make sure you're working with the correct team.    The team 
name is listed on all update screens.    Changing the team name has NO 
effect on game and player results recorded for that team.    Game and player 
results relate to the relative team number, NOT the team name.



Change Player Number
Select Change Player Number from the Update Menu to move a player's 
name and statistics to another player number on the roster.    You can only 
change a player's number if NO results have been recorded for the number 
you want to change to.    This function could be used so a player has the 
same number every year for computing career statistics by player number.    
However, you can also compute career statistics by player name.
Player numbers do NOT appear on any reports.    Don't get hung up on the 
player number.    It's a throw back from the DOS version of StatTrak for 
Baseball and will probably be eliminated in a future version of StatTrak for 
Hockey.



Delete Files
Select Delete Files from the Update Menu to delete the team name, roster, 
game results, and player results for the selected team.    This function could 
be used to delete games that were added while experimenting with the 
program.
BE VERY CAREFUL USING THIS FUNCTION.    The team name, roster, 
game results, and player results recorded for the selected team will be 
permanently deleted!
Periodically make a backup copy of your game and player files.



Options
Selecting Options from the Main Menu provides the following menu option:

Name Your Own - Name your own game types and categories.
The next version of StatTrak for Hockey will probably have an additional 
option to Create Your Own Statistics.



Data Directory
Select Data Directory from the File Menu to select the team and player file 
directory you want to work with.    Each directory can track up to 100 teams.
StatTrak will NOT make a directory for you.    You must do it.



Name Your Own
Select Name Your Own from the Options Menu to name game types and 
additional goalie and non-goalie categories.
With StatTrak every game is assigned a game type.    With Name Your Own 
you can name up to 7 game types.    For example, you could name game 
type 1 LEAGUE and game type 2 PRACTICE.    Then you would select the 
LEAGUE game type when adding league games and the PRACTICE game type
when adding practice games.    You could then compute statistics for league 
games by only selecting the LEAGUE game type on the Compute Screen, 
practice games by only selecting the PRACTICE game type, or league and 
practice games by selecting the LEAGUE and PRACTICE game types.    When 
computing reports, only the relative position of the selected game types are 
important, the names are just labels you assign.
You can also name up to 5 additional categories for goalies and non-goalies.   
To track high-sticking, you could name a category HS and then record results 
under that heading when adding player results.    Then by selecting HS on the
Format Screen, you could add high-sticking to the Team and Player Report.    
Naming a category is for labeling purposes only.    Statistics relate to the 
relative position of the Name Your Own category, NOT the category name.
You might want to name your own game types and categories before you 
start adding games.    However, you can name them at any time.



Team and Player Statistics
Below is a list of the statistics that are tracked and computed by StatTrak for 
Hockey:

Players Other Than Goalie:
Per Periods Played OT Overtime Goals
Min Minutes Played UA Unassisted Goals
SOG Shots on Goal A Assists
G Goals Scored Pen Penalties
PP Power-Play Goals PIM Penalty Minutes
SH Short-Handed Goals FOW Face-Offs Won
GW Game Winning Goals FOL Face-Offs Lost
EN Empty Net Goals +/- Plus/Minus
H1, H2, H3, H4, H5    User Named Categories (renamable)
GP Games Played = number of games played in
Hat Hat Trick = 1 for each game 3 or more goals are scored by individual
Sh% Shooting Percent = G / SOG
Pts Points = 1 point for each goal and 1 point for each assist
PPG Points per Game = Pts / GP
FO% Face-Off Percent = FOW / (FOW + FOL)

Goalie:
Per Periods Played
Min Minutes Played
GA1 Goals Against in Period 1
GA2 Goals Against in Period 2
GA3 Goals Against in Period 3
GAO Goals Against in Overtime
Sv1 Saves in Period 1
Sv2 Saves in Period 2
Sv3 Saves in Period 3
SvO Saves in Overtime
W Games Won
L Games Lost
T Games Tied
G1, G2, G3, G4, G5    User Named Categories (renamable)
GP Games Played = number of games played in
GA Total Goals Against = GA1 + GA2 + GA3 + GAO
Sv Total Saves = Sv1 + Sv2 + Sv3 + SvO
Sv% Save Percent = Sv / (Sv + GA)
GAA Goals Against Average = GA / (Min / minutes per game which is set by user)



Other Programs
Other Windows Programs available from ALL-PRO Software:

* StatTrak for Baseball (and Softball) $39.95
Works very much like StatTrak for Hockey!
Rated #1 by the Society for American Baseball Research (SABR) software
review.

* StatTrak for Basketball $39.95
* StatTrak for Soccer $39.95
* StatTrak for Volleyball $39.95
* ALL-PRO League Scheduler $49.95

Create round-robin schedules in minutes!
Handles division play and tracks scores and standings.

$3.75 shipping and handling per order!

Other Windows Programs soon to be released by ALL-PRO Software:
Release Date

* ALL-PRO Tournament Scheduler February 1st, 1997
* StatTrak for Football July 1st, 1997

To order or for more information, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa).    International orders are welcome - call 608-271-1586!
Check out our Home Page (demos available for downloading):

http://www.msn.fullfeed.com/~allpro/
or Email us:

allpro@msn.fullfeed.com
Let us know what other features and sports programs you would like to see!



Registration
Unless this is a demo (shareware) version of StatTrak for Hockey, you must 
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you have an illegal copy and must immediately 
register with ALL-PRO Software or delete the program.
To register StatTrak for Hockey, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa) or send a check or money order for $39.95 + $3.75 shipping and 
handling to ALL-PRO Software.    International orders call 608-271-1586 or 
send a check or money order in U.S. funds drawn on a U.S. bank and use 
$5.00 for shipping and handling.    Wisconsin Residents please add 5.5% sales
tax ($2.20) for a total of $45.90.    You will receive the latest version of 
StatTrak for FREE when you register.
To register a retail copy of StatTrak for Hockey, send the registration card or 
proof of purchase to ALL-PRO Software if you wish to receive the benefits 
listed below.    No fee is required.
If you obtained the program from ALL-PRO Software, you are automatically 
registered and will receive the benefits listed below.
Registration Benefits:

*    You will be notified when major upgrades to StatTrak for Hockey are 
released.    They will be offered to you at a reduced price.    The program 
will be upgraded every year.

*    You will be notified when other programs are released or upgraded by 
ALL-PRO Software.

* You can receive FREE technical support at 608-271-1586.    Please don't 
use the 800 number for technical support.    The 800 number is for orders 
only.    Thank you!



Technical Support
For technical support:

* Call us at 608-271-1586.    Please don't use our 800 number which is 
reserved for orders.

* Fax us at 608-277-9195.
* Write us at All-Pro Software, 30 Maple View Court, Madison, WI 53719
* Email us at allpro@msn.fullfeed.com



License
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING ITS MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.      NEITHER ALL-PRO SOFTWARE NOR ANYONE ELSE 
INVOLVED IN CREATING, PRODUCING OR DELIVERING THIS SOFTWARE SHALL BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF USE OF THIS SOFTWARE OR INABILITY TO USE THIS 
SOFTWARE.      IN NO EVENT SHALL ALL-PRO SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE REGISTRATION FEE, REGARDLESS OF THE FORM OF 
CLAIM.    THE ENTIRE RISK AS TO QUALITY AND PERFORMANCE IS WITH THE USER.
THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF WISCONSIN 
AND SHALL INURE TO THE BENEFIT OF ALL-PRO SOFTWARE.    ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR 
RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL 
COURT OF COMPETENT JURISDICTION LOCATED IN DANE COUNTY, WISCONSIN.    THE
PARTIES HEREBY CONSENT TO JURISDICTION OF SAID COURTS. 
THIS SOFTWARE AND THE DISKS ON WHICH IT IS CONTAINED IS LICENSED SOLELY 
TO YOU ON A PERPETUAL BASIS FOR YOUR OWN USE. THIS IS COPYRIGHTED 
SOFTWARE.    YOU ARE NOT OBTAINING TITLE TO THE SOFTWARE OR ANY 
COPYRIGHT RIGHTS.    YOU MAY NOT SUBLICENSE, RENT, LEASE, CONVEY, MODIFY, 
TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, DECOMPILE, OR 
DISASSEMBLE THE SOFTWARE FOR ANY PURPOSE.    RECEIPT AND USE OF THE 
PRODUCT IS YOUR AGREEMENT TO THE TERMS OF THIS LICENSE.




